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Preface
PREFACE Welcome

Purpose of This Manual

This manual contains detailed information about how to configure and deploy 
EtherNet/IP and PROFINET I/O-based applications using CS50 Software and 
the CS50 Sensor.

Manual Conventions
The following typographical conventions are used throughout this manual.

• Items emphasizing important information are bolded.

• Menu selections, menu items and entries in screen images are 
indicated as: Run (triggered), Modify..., etc.
CS50 Software Industrial Protocol Manual v
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CHAPTER 1 Enabling Industrial Protocols

This section describes how to enable EtherNet/IP for the CS50 Sensor, 
and how to switch the CS50 Sensor’s protocol between EtherNet/IP and 
PROFINET I/O.
CS50 Software Industrial Protocol Manual 1-1
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Enabling Protocols for the CS50 Sensor

CS50 Software – CS50 Sensor

In the Connect view, and with a CS50 Sensor selected, click the button to 
the left of Details (directly below the image of the CS50 Sensor) to view 
camera settings. Click Modify at the bottom of the dialog to change 
camera settings. Select the desired protocol from the Industrial Protocol 
dropdown menu, and then click Apply at the bottom of the dialog.

You will see the Reboot Required dialog after clicking Apply.

Note: A change to Industrial Protocol requires a reboot of the camera 
before the new setting can take effect.

Choose Yes and the camera will be rebooted for you. CS50 Software will 
be disabled while the reboot is in process. If you choose No, the change 
will not take effect until you manually reboot the camera.
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CHAPTER 2 Using EtherNet/IP

This section provides information necessary for using the CS50 Sensor 
in an EtherNet/IP environment.

Notes: 

• The camera communications protocol must be enabled for EtherNet/IP
before it can be used in this environment. Refer to Chapter 1,
Enabling Industrial Protocols, for information about enabling
communications protocols for the CS50 Sensor, and information about
switching CS50 Sensor communications protocols.

• CS50 Software jobs use di-soric Link functionality to accommodate
EtherNet/IP communications between the camera and the PLC. For
information about how to connect job parameters and outputs to di-soric
Link tags, refer to the di-soric Link section of CS50 Software Help.
CS50 Software Industrial Protocol Manual 2-1



Chapter 2 Using EtherNet/IP
EtherNet/IP for the CS50 Sensor

Overview

The EtherNet/IP interface will be identified as Vendor Specific (100). The 
interface is designed to support Class 1 Implicit I/O data exchange, and 
Class 3 Explicit messages for serial commands not accessible with 
Implicit messaging.

Necessary Tools

The following tools are helpful for configuring EtherNet/IP:

• CS50 Software

• EtherNet/IP Messaging Tool – can be a PLC or Software Tool, must 
be capable ofsending explicit messages and establishing Class 1 
connections. EIPScan from Pyramid Solutions is an example of such 
a tool.

• Terminal emulation or serial communication tool that can connect to 
serial uart and TCP socket, such as HyperTerminal or Putty.

EtherNet/IP Terms of Use

EtherNet/IP Technology is governed by the Open DeviceNet Vendor 
Association, Inc (ODVA). Any person or entity that makes and sells 
products that implement EtherNet/IP Technology must agree to the Terms 
of Usage Agreement issued by ODVA. See www.odva.org for details.
2-2 CS50 Software Industrial Protocol Manual
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EtherNet/IP Object Model

The CS50 Sensor uses Class 1 connected messaging to communicate 
most of its data and services in a single connection.

EtherNet/IP Identity

Device Type

Device type is 100, Vendor Specific, Machine Vision Camera.

Vendor ID

di-soric’s ODVA Vendor ID is 1095.

Product Code

The CS50 Sensor Product Code is 7000.

Interface Revision

Major.Minor  = 1.1

Connection Properties: Class 1 Implicit Messaging

Input Assembly Instance (to PLC/client): 102

Output Assembly Instance (to camera): 114 

Size: Fixed, 320 bytes in both directions

Input Trigger/Trigger Mode: Cyclic

RPI (Requested Packet Interval): Greater than 20 ms recommended. 10 
ms to 3.2 s allowed.

Input Type/Connection Type: 

• Point-to-Point (PLC OUT, O > T)

• Point-to-Point (PLC IN, T > O)

Connection Priority: Scheduled
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Assembly Layout

Input Assembly

The input assembly layout is described below.
2-4 CS50 Software Industrial Protocol Manual
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The input assembly layout is shown here:
CS50 Software Industrial Protocol Manual 2-5
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Status: Camera Status Register (16-bit)

Each bit of this register represents a different state of the camera’s operation. A high value 
of 1 indicates that state is active (true).
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CmdCodeRslt (32-bit)

The value of CmdCodeRslt is only valid when ExeCmdAck is active (1), in response to 
ExeCmd being active. 

CmdRet (32-bit)

The value of CmdRet is only valid when ExeCmdAck is active (1), in response to 
ExeCmd being active, and CmdCodeRslt is 0 (Success). The following table shows 
which CmdCodes return data in the CmdRet register.
CS50 Software Industrial Protocol Manual 2-7
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State (16-bit)

State reflects the following operational condition of the camera:

*Booting (3) State: This will rarely be seen by the PLC.
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The value of State determines which Control and Status signals are available:

Where:

Y = Signal is valid for this State 

Empty table cell = Signal is not valid for this State
CS50 Software Industrial Protocol Manual 2-9



Chapter 2 Using EtherNet/IP
VIO Register Bits

Output Assembly

The output assembly layout is described below and shown in the following diagram.
2-10 CS50 Software Industrial Protocol Manual



Assembly Layout

U
si

n
g

 E
th

er
N

et
/IP

2

The output assembly layout is shown here:
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Chapter 2 Using EtherNet/IP
Control: Camera Control Register (16-bit)

Each bit of this register controls a function on the camera. Transitions from a low state of 0 to a 
high state of 1, initiates the associate operation. The PLC should return the state of the control 
bit back to 0 after it has acknowledged the camera has processed the control. Unused bits 
should remain 0.

CmdCode and CmdArg (32-bit)

Specifies the process invoked in the camera when Control.ExeCmd goes active.

List of available CmdCodes, and associated CmdArg:
2-12 CS50 Software Industrial Protocol Manual
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CmdCode and ExeCmd Operation

VIO Register Bits
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Chapter 2 Using EtherNet/IP
Connection Properties: Class 3 Explicit Messaging

All Class 1 I/O assembly data and additional data are accessible via Explicit message. 
Input data (camera to PLC/Client) occupies attributes 1 to 100 of the classes. Output data 
(PLC/Client to camera) occupies attributes 101 to 200.

Service: 

• Get Attribute Single (0xE) 

• Set Attribute Single (0x10)

Classes:

• bool =  104 (0x68)

• int = 105 (0x69)

• long = 106 (0x6A)

• float = 107 (0x6B)

• string = 108 (0x6C)

• control/status (mixed data types) = 109 (0x6D)

Instance: 1

Attribute: 

• 1 to 100  = In to PLC/Client

• 101 to 200 = Out to Camera
2-14 CS50 Software Industrial Protocol Manual
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Attribute Layout

When using explicit EtherNet/IP messaging, all global data objects can be read or written. 
Each data type is stored in its own class object and an instance of 1 to read the global 
data. For example, to read float2, the EtherNet/IP request would be for Service Code 14 
(0xE), Class 107 (0x6B), Instance 1, Attribute 2. 

The value received in response to Get Attribute Single depends on the type:

• Bool will return a 16-bit word with 0 for false or 1 for true

• Ints will return a 16-bit signed integer

• Longs will return a 32-bit signed integer

• Floats will return a 32-bit floating point number

• Strings will return a counted string. Total size of a string data item is 2048 bytes. This 
includes a 4 byte “length” field followed by 2044 eight bit characters. When accessing 
strings explicitly, they are not limited to the size in the I/O assemblies. For example, 
string3 is limited to 28 bytes in the input assembly. If the actual string is longer than 
28 bytes, it will be truncated when reading via the assembly, but not truncated when 
reading the same string via an attribute explicitly.
CS50 Software Industrial Protocol Manual 2-15



Chapter 2 Using EtherNet/IP
Assembly Class 109 can be used to read and write special EtherNet/IP-specific 
registers.
2-16 CS50 Software Industrial Protocol Manual
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EtherNet/IP Control/Status Signal Operation
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Data Type Descriptions and Equivalents in PLC and 
EDS/CIP Environments
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PLC Tags and Serial Command Names 

PLC tags are separated into IN and OUT for data direction. Within the IN and OUT groups, 
the tags are sub-divided into fixed Status and Control fields, plus user-defined linked data 
fields. This table shows how PLC tag names correspond to serial commands.
CS50 Software Industrial Protocol Manual 2-19
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CHAPTER 3 Allen-Bradley AOI (Add-On 
Instructions) for EtherNet/IP 
Operation

This section provides additional instructions helpful for using the CS50 
Sensor in an EtherNet/IP environment.

Notes: 

• The camera communications protocol must be enabled for EtherNet/IP
before it can be used in this environment. Refer to Chapter 1,
Enabling Industrial Protocols, for information about enabling
communications protocols for the CS50 Sensor, and information about
switching CS50 Sensor communications protocols.

• CS50 Software jobs use di-soric Link functionality to accommodate
EtherNet/IP communications between the camera and the PLC. For
information about how to connect job parameters and outputs to di-soric
Link tags, refer to the di-soric Link section of CS50 Software Help.
CS50 Software Industrial Protocol Manual 3-1



Chapter 3 Allen-Bradley AOI (Add-On Instructions) for EtherNet/IP Operation
Rockwell RSLogix 5000 AOI (Add-On Instructions) for di-soric 
Devices

The AOI file has been created as basic instructions and as a main rung import. The AOI 
instructions read and write data when called. The main rung import has global tags and 
the AOI itself to demonstrate how the AOI is used for beginners with the RSLogix system. 
The AOI can be used with the EDS file.

Note: Examples in this section have been created using RSLogix 5000 version 20.

Steps

• Install EDS File

• Import AOI File

• Test Communications and Review Data

Install EDS File

In RSLogix 5000, select the EDS Hardware Installation Tool under the main menu Tools.

Click the Next button. Make sure the Register an EDS Files(s) radio button is selected.
3-2 CS50 Software Industrial Protocol Manual
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Click the Browse button to locate the EDS file (C:\di-soric\Vscape\Firmware\eds\). Once 
the EDS file is located and selected, click the Next button.

Click the Next button for the image. Click the Next button for the summary.

Click the Finish button to complete the EDS installation.
CS50 Software Industrial Protocol Manual 3-3



Chapter 3 Allen-Bradley AOI (Add-On Instructions) for EtherNet/IP Operation
Right-click the Ethernet node on the left pane and select New Module. Enter the part 
number in the filter box to list the device. Select the device from the newly added EDS file. 
Double-click the device or select and click the Create button to add to the project.

Enter the name for your device and the IP address, then click OK.
3-4 CS50 Software Industrial Protocol Manual
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If the reader has multiple assembly sizes, the Change button allows you to select the 
other assembly formats.

Click the Close button on the module selection dialog to continue. Now the device has 
been added to the project and will be visible in the tree view under the Ethernet node.
CS50 Software Industrial Protocol Manual 3-5
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Import AOI File

Right-click the Add-On Instructions node in the tree view in the left pane and select 
Import Add-On Instruction. Locate the L5X file (C:\di-soric\Vscape\Firmware\aoi\) and 
click the Import button.

The Import Configuration dialog will prompt you for information regarding the AOI file. Select 
the Data Types to view the new tags and their attributes. Click OK when ready to continue.

New tags and logic will now be added to the project.
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Test Communications and Review Data

After the reader module has been installed, you can start with a basic ladder logic program 
to test the data to and from the device. Two steps are involved to test the communication: 
(1.) Download an autovision job; (2.) Add logic to the PLC ladder logic.

Start by opening up CS50 Software and select the camera.

Select Load a Job.

Navigate to di-soric > Vscape > Tutorials and Samples > EIP Demo > 
SimpleTrigger_Job.avp. 

This job has not tools loaded and is a simple job that allows the PLC to trigger the camera. The 
user can also set another Trigger action in the Trigger panel on the right hand of the screen.

Now download the job to the camera by selecting the Save Job to Camera icon and 
selecting New Slot.
CS50 Software Industrial Protocol Manual 3-7
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Select Yes to download the program to flash to the camera.

Next add the logic to the PLC. Do this by opening the MainRoutine editor and create an 
Add-On-Instruction.

Right-click in the first element and create a New Tag.
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Right-click the second element and create a new tag for the Assembly_Input. It will 
default to the AOI INPUT320 data type. Right-click the third element and create a new tag 
for the Assembly_Output. It will default to the AOI OUTPUT320 data type.

Double-click the fourth element and click the down arrow in the combo box to link the 
Connection_Input to the reader input data. The link should be the [reader name]:I.Data.

Note: Do not connect to the ConnectionFault item.

Double-click the fifth element and click the down arrow in the combo box to link the 
Connection_Output to the reader output data. The link should be the [reader name]:O.Data.
CS50 Software Industrial Protocol Manual 3-9
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Add a new rung by right-clicking and selecting Add Rung.

Create an Examine On trigger tag.

Right-click and create a Boolean Trigger.
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Add an Output Engerized tag to the end of the rung.

Assign the Output Engerized tag to the WriteData.CONTROL.8 bit.

Now download the program to the PLC. Once the program has downloaded, set the PLC 
to Run Mode.

Note: Be sure the path to the PLC has been set in the project so that communications to 
the PLC can be established.
CS50 Software Industrial Protocol Manual 3-11



Chapter 3 Allen-Bradley AOI (Add-On Instructions) for EtherNet/IP Operation
Toggle the bit Trigger by right-clicking and selecting Toggle Bit or by typing Control + T.

This action will set the Trigger tag high, causing the trigger output bit to go high in the Output 
Assembly. The camera will trigger on each rising edge (i.e. when the Trigger tag is set to 1). 
This will confirm that communication is established between the PLC and the camera.
3-12 CS50 Software Industrial Protocol Manual
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CHAPTER 4 Allen-Bradley PLC Setup 
via EDS for EtherNet/IP 
Operation

This section describes how to use an EDS file to set up an Allen-Bradley 
PLC for EtherNet/IP operation.

Notes: 

• The camera communications protocol must be enabled for EtherNet/IP
before it can be used in this environment. Refer to Chapter 1,
Enabling Industrial Protocols, for information about enabling
communications protocols for the CS50 Sensor, and information about
switching CS50 Sensor communications protocols.

• CS50 Software jobs use di-soric Link functionality to accommodate
EtherNet/IP communications between the camera and the PLC. For
information about how to connect job parameters and outputs to di-soric
Link tags, refer to the di-soric Link > section of CS50 Software Help.
CS50 Software Industrial Protocol Manual 4-1



Chapter 4 Allen-Bradley PLC Setup via EDS
AB Rockwell RSLogix 5000 v20 PLC Integration with EDS

This section was created and run on the following Allen Bradley/Rockwell components:

• RSLogix 5000 Version 20.00.00 (CPR 9 SR 5)

• 756-L61 ControlLogix5561 Controller, firmware rev 20.11

• 1756-ENBT/A EtherNet/IP interface card, firmware rev 4.1

Run the Rockwell EDS Hardware Installation Tool.
4-2 CS50 Software Industrial Protocol Manual



AB Rockwell RSLogix 5000 v20 PLC Integration with EDS

A
lle

n
-B

ra
d

le
y 

P
L

C
 

S
et

u
p

 v
ia

 E
D

S

4

Select Add.

Select Browse.
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Chapter 4 Allen-Bradley PLC Setup via EDS
Navigate to the CS50 Sensor EDS file, then Open it. The default install location is C:\di-
soric \Vscape\Firmware\eds\CS50.

Keep clicking Next until the Finish button is displayed. 
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Click Finish.

Open RSLogix 5000 v20 and create the I/O Configuration for the base system, including 
the system’s Ethernet interface.
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Chapter 4 Allen-Bradley PLC Setup via EDS
Right-click Ethernet and select New Module.

The Select Module Type dialog will be displayed.
4-6 CS50 Software Industrial Protocol Manual
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Clear the Module Type Vendor Filters.

Scroll down the Module Type Vendor Filters until di-soric comes into view, then select di-soric.
CS50 Software Industrial Protocol Manual 4-7



Chapter 4 Allen-Bradley PLC Setup via EDS
Click the required camera and click Create.

The New Module dialog is displayed. Type a unique name for this camera and its IP address.
4-8 CS50 Software Industrial Protocol Manual



AB Rockwell RSLogix 5000 v20 PLC Integration with EDS

A
lle

n
-B

ra
d

le
y 

P
L

C
 

S
et

u
p

 v
ia

 E
D

S

4

Click OK, verify the camera was added to the Ethernet network, then open the controller 
tags to verify that :I and :O tag sets were created.

Open the Main Routine.
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Chapter 4 Allen-Bradley PLC Setup via EDS
Right-click rung 0, and select Import Rungs.

Navigate to the CS50 Sensor 32-000003-2.L5X file and select Import. The default install 
directory is C:\di-soric\Vscape\Tutorials and Samples\CS50\EIP Demo.
4-10 CS50 Software Industrial Protocol Manual
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The Import Configuration dialog will be displayed.

Select Tags.
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Chapter 4 Allen-Bradley PLC Setup via EDS
In the Final Name column, click Camera:I, then click the down arrow that appears on the right.

Double-click the camera name input tag assigned earlier.
4-12 CS50 Software Industrial Protocol Manual
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In the Final Name column, click Camera:O, then click the down arrow that appears on the right.

Double-click the camera name output tag assigned earlier.
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Click the Other Components icon in the tree view to select the Component References. 
Select the camera in the Final Name column. Click OK to complete the import. 

Click OK and the Main Routine and User-Defined tags will be populated.
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Delete any empty rungs (check rung 0).

Download the project to the PLC.

Note: Be sure the path to the PLC has been set in the project so that communications to 
the PLC can be established.

Put the PLC in Run Mode.
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Chapter 4 Allen-Bradley PLC Setup via EDS
Open the Program Tags window and select Monitor Tags.
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Expand Scan_MV_IO_user so that the Echo in the .IN.Status and .OUT.Control 
structures is visible.
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Chapter 4 Allen-Bradley PLC Setup via EDS
Change .OUT.Control.Echo to non-zero.

Verify that Scan_MV_IO_user.IO.IN.Status.Echo is the same value as the 
.OUT.Control.Echo.

This confirms that the PLC and camera have successful two-way communication. 

The demo code expects a demo vision job to be loaded on the camera, which populates 
the following input tags (camera to PLC) with vision tool results:

• .IN.bool.bool1, bool2, and bool3

• .IN.long.long1

• .IN.float.float1

• .IN.string.string1

The demo code will operate the Control and Status signals of the camera regardless of 
the vision job that is loaded. For a more detailed overview of the demo code and vision 
job, see Allen-Bradley PLC Setup via Generic Ethernet Module for EtherNet/IP 
Operation. 

To send a trigger to the camera, scroll to Scan_MV_IO_user.Control.Trigger.
4-18 CS50 Software Industrial Protocol Manual
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Set the Trigger to 1. This causes the demo code to trigger the camera, process the new 
inspection data, record the results in the Scan_MV_demo_xxxx tags, and clear the 
DataValid status signal. 

The Trigger control changes to 0 when the camera is triggered. All processing is done 
when the counter Scan_MV_dv_fall_count increments, along with the pass/fail counters 
in the Scan_MV_demo_xxxx tags.
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CHAPTER 5 Allen-Bradley PLC Setup via 
Generic Ethernet Module for 
EtherNet/IP Operation

This section describes how to use the Generic Ethernet Module to set up 
an Allen-Bradley PLC for EtherNet/IP operation.

Notes: 

• The camera communications protocol must be enabled for EtherNet/IP
before it can be used in this environment. Refer to Chapter 1,
Enabling Industrial Protocols, for information about enabling
communications protocols for the CS50 Sensor, and information about
switching CS50 Sensor communications protocols.

• CS50 Software jobs use di-soric Link functionality to accommodate
EtherNet/IP communications between the camera and the PLC. For
information about how to connect job parameters and outputs to di-soric
Link tags, refer to the di-soric Link section of CS50 Software Help.
CS50 Software Industrial Protocol Manual 5-1
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Integrating the Camera into a PLC Environment

This section assumes you are using an Allen Bradley PLC with Rockwell RSLogix 5000 v16 
or newer. RSLogix v19 and v20 may look slightly different than the screen shots shown, but 
the integration process is similar.

Create the I/O Configuration for the base system, including the system’s Ethernet interface. 

Add the camera by right-clicking the Ethernet interface and selecting New Module.
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Select ETHERNET-MODULE – Generic Ethernet Module, and click OK.
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Configure the following fields:

Name: A useful name to rememberfor the camera. The example here is Scan_MV.

IP Address: The IP Address of the camera

Comm Format: “Data – DINT”

Input, Assembly Instance: 102 

Input, Size: 80 

Output, Assembly Instance: 114

Output, Size: 80

Configuration, Assembly Instance: 1

Configuration, Size: 0 (none)

Click OK when done.

Example:
5-4 CS50 Software Industrial Protocol Manual
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Configure the Required Packet Interval (RPI) and click OK. 

10 ms is the minimum allowed by the camera. 20 ms or higher is recommended.

Open the Main Routine.
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Right-click the top rung and select Import Rung.

Navigate to the 32-000003-2.L5X file and click Import.
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CS50 Software Industrial Protocol Manual 5-7

At the Import Configuration window, find the Module Name that was assigned to the 
Generic Module. Here the module name is Camera.

Click Camera:I and click the down arrow, then double-click the Scan_MV:I that appears 
below it.
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Click Camera:O and click the down-arrow, then double click the Scan_MV:O that appears 
below it.

Click the Other Components icon in the tree view. Click OK.

Delete any empty rungs (rung 0 may be empty).

The tags and main program are now configured sufficiently to test communication with the 
camera.
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Select the control button next to Offline and then select Download.

Note: Be sure the path to the PLC has been set in the project so that communications to 
the PLC can be established.
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Once the program has downloaded, make sure the PLC is in Run Mode.

To open the Program Tags, double-click Program Tags, then select the Monitor Tags tab 
at the bottom of the tag window.
5-10 CS50 Software Industrial Protocol Manual
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Expand Scan_MV_IO_user so that the .IN.Status and .OUT.Control structures are 
visible. Then scroll the window so Scan_MV_IO_user.OUT.Control.Echo is visible.
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Change .OUT.Control.Echo to non-zero.
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Scroll the window so Scan_MV_IO_user.IO.IN.Status.Echo is visible, and verify that it is 
the same value as .OUT.Control.Echo.

This confirms that the PLC and camera have successful two-way communication. 
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To send a trigger to the camera, scroll to Scan_MV_IO_user.Control.Trigger.
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Set the Trigger to 1. This causes the demo code to trigger the camera, process the new 
inspection data, record the results in the Scan_MV_demo_xxxx tags, and clear the 
DataValid status signal. The Trigger control changes to 0 when the camera is triggered. 
The Scan_MV_dv_fall_count and pass/fail counters in the Scan_MV_demo_xxxx tags 
increment when all processing is done. For example:
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Parameterize the Camera

Open the Scan_MV_IO_user.OUT.long, float, and string tags and verify that they are 
configured as shown below.

This configures the Measure (float101 and float102), Decode (string101) and Count 
Blob (long101 and long102) tools in the same way they were configured in CS50 
Software during Try Out.

Note the Description column. It offers a hint for what each linked tag does in the vision job.
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Trigger the Camera

To send a trigger to the camera, scroll to Scan_MV_IO_user.Control.Trigger. 

Set the Trigger to 1. When the Trigger returns to a value of 0, the camera may be re-triggered.

If you connect to the camera with CS50 Software, it will display a new inspection result 
each time the camera is triggered. Recall that the vision job was created with predefined 
images to produce predictable Passed and Failed results. The camera’s illumination 
lights will not flash when triggered.

The inspection results can be seen in the PLCs’s IN tags, as well as in CS50 Software. 
Open the RSLogix tag window so Scan_MV_IO_user.IN.Status and bool are visible. 
CS50 Software Industrial Protocol Manual 5-17
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This example shows a Passed inspection, where the following tags are all 1:

• IN.Status.InspStat

• IN.bool.bool1 (Measure status)

• IN.bool.bool2 (decode+matchcode status)

• IN.bool.bool3 (count blob status)
5-18 CS50 Software Industrial Protocol Manual
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If you scroll down to the IN.long, float, and string values, you will see the literal results of 
the vision tools.
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This is equivalent to the CS50 Software inspection result.

This example shows a Failed inspection, where every tool reports a fail.
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This is the Failed inspection’s literal data.

This is equivalent to the CS50 Software inspection report.
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Parameterize the Camera Again

The Measure and Count Blob tools can be parameterized by the PLC so they always 
pass. The Decode Tool can be parameterized so it always fails, either due to no decode, 
or a Match Strings mismatch. Scroll the tag window so OUT.long, float, and string are 
visible, then change them as shown below.
5-22 CS50 Software Industrial Protocol Manual



Integrating the Camera into a PLC Environment

A
lle

n
-B

ra
d

le
y 

P
L

C
 

S
et

u
p

 v
ia

 G
en

er
ic

 
E

th
er

n
et

 M
o

d
u

le

5

Trigger the Camera Again

Trigger the camera twice and you will see the Status results stay the same for all triggers:

bool2 (decode+matchcode status) = 0

Why: Decode + Matchcode status always fails because the matchcode has been changed 
to wrong code, or there is no decode.

bool1 (Measure status) and bool3 (count blob status) = 1

Why: The inspected values are now within tolerance.

InspStat = 0

Why: The Decode tool fails, so the overall Inspection result is a Fail.

PLC tags:

This concludes the EtherNet/IP demo.
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CHAPTER 6 Demo EtherNet/IP PLC Code

This section describes how to use di-soric demo PLC code with a vision 
job and camera target.

The EtherNet/IP demo files can be found where CS50 Software is 
installed, in the folder C:\di-soric\Vscape\Tutorials and 
Samples\CS50\EIP demo. Open the EIP_demo.avp with CS50 Software 
and download it to the camera. 

During PLC integration, import the 32-000003-2.L5X file to create the 
camera’s demo tags and ladder logic.

Notes: 

• The camera communications protocol must be enabled for EtherNet/IP
before it can be used in this environment. Refer to Chapter 1,
Enabling Industrial Protocols, for information about enabling
communications protocols for the CS50 Sensor, and information about
switching CS50 Sensor communications protocols.

• CS50 Software jobs use di-soric Link functionality to accommodate
EtherNet/IP communications between the camera and the PLC. For
information about how to connect job parameters and outputs to di-soric
Link tags, refer to the di-soric Link section of CS50 Software Help.
CS50 Software Industrial Protocol Manual 6-1
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Glossary of Terms

The following terms are used in the description of di-soric’s demo PLC 
program.

Camera

The di-soric camera used in this application, which has an EtherNet/IP 
communication interface.

User App

The PLC logic code written by the end user or system integrator.

Demo Code

The PLC logic code distributed by di-soric that can be imported into the 
PLC’s ladder logic area. It encapsulates most of the device Control and 
Status management.

The demo code expects a demo vision job loaded on the camera. 
However, the demo code will operate whether or not the demo vision job 
is loaded on the camera.

Activate / Set High

Writing a 1 value to a single Control bit, or any other bool bit.

Active 

A Control, Status, bool, or PLC logic “contact” in a 1 state.

Clear 

A Control, Status, bool, or PLC logic “contact” in a 0 state.

One Shot

A PLC tag write operation that is performed once, typically in reaction to 
an event. After a one shot operation, the PLC logic does not write to the 
same tag again unless another event occurs.
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Demo Setup

Vision Job Setup

The EtherNet/IP demo files can be found where CS50 Software is 
installed, where the default folder is C:\di-soric\Vscape\Tutorials and 
Samples\CS50\EIP demo. 

1. Open EIP_demo.avp with CS50 Software.

2. To use pre-defined images, select the icon shown here.

3. Browse to the EIP demo folder, select it, and click OK.
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After the EIP demo folder has been enabled for image load, the 
camera icon will change to a folder.

4. While in Edit mode, Try Out can be used to get an understanding of 
what to expect after the job is sent to the camera.

Before Try Out can be effective, the Measure, Decode, and Count 
Tool parameters must be specified. After job download, the tool 
parameters will be supplied by the PLC.

Measure Tolerance:

Decode Matchstring:

Count Tolerance:
6-4 CS50 Software Industrial Protocol Manual
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With these tool parameter configured as shown, Try Out will show the 
following Pass/Fail results:

Fail:

Pass:

5. Download the job to the camera.

6. Add the camera and demo code to the PLC environment (see the 
next section).

PLC Demo Code Setup

During PLC integration, import the 32-000003-2.L5X file found in the EIP 
demo folder to create the camera’s demo tags and ladder logic (refer to 
the Allen-Bradley PLC Setup chapters).
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Description of PLC Tags

Scan_MV_demo_mode

Purpose

This tag is intended for demonstration purposes only. It modifies the 
operation of the demo code and allows the first-time user to control the 
device directly with no assistance from the demo code. It also allows the 
demo code to manage the Control and Status signals fully.

The demo mode tag takes three different values, putting the demo code 
into one of three modes of operation: 

• Exchange I/O data only

• Actively operate device controls, status, and demo data

• Automatically trigger the device after one second of idle time

User App Method

User app can set the demo mode with one of three values to define the 
demo code’s mode of operation.

0 = Exchange I/O data only

In this mode, the user directly accesses the Scan_MV_IO_internal tag 
set. The demo code only exchanges data with the camera, doing nothing 
to control the device or respond to events from it.

1 = Operate device controls and respond to device events

This is the default mode of the demo code. In this mode, the user app 
accesses the Scan_MV_IO_user tag to control and monitor the camera. 
The user app must not access the Scan_MV_IO_internal tag set. 

In this mode, the user activates the controls in 
Scan_MV_IO_user.OUT.Control (Trigger, ResetCount, GoOnline, 
GoOffline, ResetError, ExeCmd), and the demo code handles the rest.

2 = Auto-trigger
6-6 CS50 Software Industrial Protocol Manual



Description of PLC Tags

D
e

m
o

 E
th

er
N

et
/IP

 P
L

C
 

C
o

d
e

6

In this mode, the demo code fully manages the Control and Status 
signals, the same as when the mode is set to 1. It also activates the 
camera’s trigger after one second of idle time. The timer used to drive the 
trigger is Scan_MV_trigger_delay_timer.

Demo Code Usage

Depending on the mode, the demo code will run the appropriate level of code. 

• In mode 0, only the I/O exchange rungs are executed. All others are 
bypassed. 

• In mode 1, the auto-trigger rungs are bypassed. This is the default 
mode of the demo code.

• In mode 2, all rungs are executed. 

Scan_MV_IO_user

Purpose

User-accessible I/O data for the camera. The user app reads and writes 
these I/O tags, and the demo code handles the actual on-the-wire control 
of the camera. 

User App Method

Activate a Control by setting its value to 1. 

The user app can determine that the Control is done when the Control is 
clear (demo code changes the Control to a bit/bool value of 0). Do not 
attempt to activate a Control unless it is clear.

The user app should activate the Controls using one shot writes. The use 
app should not continuously hold a Control in an active state. Holding a 
Control in an active state will prevent the demo code from notifying the 
user app that the Control operation is complete by clearing the Control. 

Usually, when a Control is clear (0), the camera is ready for the Control to 
be activated again. Please see the Specific Control Guidelines and 
Specific Status Guidelines below for qualifications.
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Demo Code Usage

The demo code waits for the user app to activate a Control. When the 
user app activates a Control, the demo code handles all handshaking and 
confirmation that the Control operation is performed by the camera. When 
the operation is complete, the demo code clears the Control back to 0. 

Specific Control Guidelines

GoOnline and GoOffline

In order to take the camera Online and Offline, only one of these Controls 
can go active (change from 0 to 1), and be active, at any given time. 

ResetCount

After the user app activates ResetCount, the demo code will clear 
ResetCount when the operation is complete. The next Inspection output 
will be 1 (as can be seen if CS50 Software is connected to the camera in 
run mode). 

Trigger

Do not trigger the camera unless the TriggerReady Status is active. If 
the Trigger goes active when TriggerReady is not active, the demo code 
increments the counter Scan_MV_trigger_err_count, and immediately 
clears the Trigger Control without attempting to trigger the camera.

After the user app activates the Trigger, the demo code will clear the 
Trigger when the camera indicates it has accepted the Trigger. 

Do not re-trigger the camera until DataValid in the Status register goes 
active, all Inspection data has been processed, and DataValid is cleared 
using the ResetDataValid Control. 

ResetDataValid

When the user app sees DataValid go active, it should process the 
Inspection data, then clear DataValid by activating ResetDataValid. 

See Data Valid for more details.
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ResetError

To clear the Error Status, activate ResetError. 

ExeCmd, CmdCode, CmdArg

These Controls can be used to perform a job change, and query the 
active job slot. The demo code includes tags with pre-defined CmdCode 
and CmdCodeRslt definitions:

The ExeCmd, CmdCode, and CmdArg controls are used in combination 
with these Status signals:

The demo code records the final result of the command operation by 
copying CmdCode, CmdArg, CmdCodeRslt and CmdRet to the 
following tags:
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The demo code will automate the command process when 
Scan_MV_demo_mode is 1, which is the default value at program 
startup, similar to how it assists the Triggering and DataValid Controls. 
The PLC integrator can initiate command operation by accessing the 
demo code’s Scan_MV_IO_user tag set for Control and Status signals. 
While a command operation is active, the demo code forces all Control 
signals to an inactive state, except for the Echo. No Controls can be 
activated until the command operation is completed. To verify the camera 
is still “alive” during command execution, Control.Echo can be 
incremented, and the Status.Echo will update accordingly.

When the demo code automates the command process, the PLC 
integrator is responsible for the following steps:

1. Deactivate all Controls and clear DataValid and Error status signals. 
This is a best-practice measure to ensure that the PLC has 
transitioned from a state of triggering and processing inspections to 
issuing a command.

2. If a job change command is to be issued, populate the output tags 
required to configure the new job (bool, int, long, float, string). 

3. Write the required CmdCode (see Scan_MV_const_CmdCode_xxxx 
tags) and CmdArg, then activate ExeCmd. 

4. Wait for ExeCmd to go inactive (per typical demo mode 1 operation). 
Note that job changes can take up to a minute. While a job change 
command is being executed, the Status.State tag will be 2. 

5. When ExeCmd goes inactive, verify the following:

   Scan_MV_CmdCodeRslt_last is 0 (Success)

   Scan_MV_CmdRest_last contains the returned data from the 
command (if any)

   Status.State has changed to 0 (Offline) or 1 (Online)

   ExeCmdAck is inactive (0)

   Status.Error is inactive (0)

6. Put the camera online (if necessary), and continue with normal 
runtime operation.
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Specific Status Guidelines

Online

The camera cannot be Triggered or generate Inspection data unless 
Online is active. See the GoOnline Control. 

TriggerReady

Do not attempt to trigger the camera unless TriggerReady is active.

See the description of the Trigger for more details. 

TriggerAck and ResetCountAck

Used by the demo code to complete the respective operations. 

DataValid

When DataValid goes active, the user app should process the Inspection 
data, then clear DataValid using the ResetDataValid control. This is 
handled, by the demo code in mode 1 and 2, as a demonstration for the 
user app.

If the camera’s DataValid goes active, but the user app has not cleared a 
previous DataValid event, the demo code does not overwrite 
Scan_MV_IO_user with new Inspection data. Instead, the demo code 
increments the counter Scan_MV_dv_err_count. The new Inspection 
data remains stranded in the Scan_MV_internal tag set, and is 
effectively lost.

Scan_MV_trigger_count

Incremented by the demo code when a new trigger is issued to the 
camera over the EtherNet/IP interface (Trigger Control activated).

Scan_MV_trigger_err_count

Incremented by the demo code if the user app attempts to trigger the 
camera when TriggerReady is not active.
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Scan_MV_dv_err_count

Incremented by the demo code when new Inspection data is received 
from the camera, but the user app has not cleared the previous DataValid.

Scan_MV_status_err_count

Incremented by the demo code whenever the Error Status goes active.

Scan_MV_demo_blob, Scan_MV_demo_decode, 
Scan_MV_demo_InspStat, Scan_MV_demo_measure

Purpose

These tags record counts and min and max values of several EIP IN data 
members.

The demo code expects a demo vision job to be loaded on the camera, 
and a demo target to be in the camera’s field of view. The demo PLC code 
will operate without the demo vision job being loaded on the camera. 
However, the data records will not be valid. 

The demo vision job has the following data members linked to certain job 
tools:

IN

Bool1 = Measure status (pass/fail)

Bool2 = Decode+Matchcode status (pass/fail)

Bool3 = Blob count status (pass fail)

Long1 = Blob count

Float1 = Measure value 

String1 = Decode text

OUT

Long101 = Blob count minimum count tolerance

Long102 = Blob count maximum count tolerance
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Float101 = Measure lower tolerance

Float102 = Measure upper tolerance

String101 = Matchcode

Each tag set records the following data for each vision job tool result received in the 
Inspection report:
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User App Method

The user app can follow the demo code’s usage of these tags for further application logic 
development.

During runtime, the user app can change the OUT data members, and observe the 
change in tool status after a new trigger. 

Specifically, the PLC integrator would typically modify the logic beginning at the following rungs:

Demo Target

The demo vision job uses predefined images. It is unnecessary to have the camera aimed 
at any specific target. If preferred, the job can be changed to enable the camera’s image 
sensor. In this case, the demo targets should be printed approximately 2.5 inches (63 
mm) wide by 1.6 inches (40 mm) tall, centered on white paper larger than the camera’s 
field of view, and presented to the camera with the Data Matrix symbol on the right:

“Pass” Image
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“Fail” Image

Demo Code Usage

The user app example of the demo code watches for Data Valid. When it goes active, the 
user app example processes the user I/O data, updates each demo record with the 
results, then uses ResetDataValid to clear DataValid.

Scan_MV_IO_internal, Scan_MV_ons_internal

Purpose

Used by the demo code to manage the camera. 

User App Method

None. The user app must not attempt to read or write to this tag set.

Demo Code Usage

The demo code uses this tag set to abstract the on-the-wire control of the camera from the 
user app. 
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Run the Camera: Runtime Operation of EtherNet/IP Demo

At this point in the evaluation, it is assumed that you have downloaded the demo vision job 
to the camera and that your PLC is running the EtherNet/IP demo code and exchanging 
data with the camera. The PLC can now parameterize, trigger and monitor the camera 
over EtherNet/IP. 
6-16 CS50 Software Industrial Protocol Manual
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CHAPTER 7 Omron PLC Setup for 
EtherNet/IP Operation

This section describes how to set up an Omron PLC for EtherNet/IP 
operation using a CS50 Sensor and CX-One software.

Notes: 

• The camera communications protocol must be enabled for EtherNet/IP
before it can be used in this environment. Refer to Chapter 1,
Enabling Industrial Protocols, for information about enabling
communications protocols for the CS50 Sensor, and information about
switching CS50 Sensor communications protocols.

• CS50 Software jobs use di-soric Link functionality to accommodate
EtherNet/IP communications between the camera and the PLC. For
information about how to connect job parameters and outputs to di-soric
Link tags, refer to the di-soric Link section of CS50 Software Help.
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Setting Up an Omron PLC

This section was created using the following Omron software and hardware:

• CX-Programmer version 9.43

• Network Configuration version 3.55

• PLC CJ2M CPU31

Start the CX-Programmer application and select menu item File > New. Enter the desired 
Device Name. Select the Device Type and then click Settings to the right of the Device 
Type menu.

In the Device Type Settings dialog, select the correct CPU Type and click OK.
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Select USB from the Network Type menu and click OK.

Connect to the PLC via USB connection. Select the menu item PLC > Work Online or 
click the online icon in the tool bar. When prompted, click Yes to complete the connection.

Once successfully connected, the background of the right pane will turn gray and the 
online icons in the ribbon will remain clicked.

To complete the next steps the PLC must be in Program Mode. Right-click the PLC node 
in the tree view in the left pane and select Operating Mode > Program.
CS50 Software Industrial Protocol Manual 7-3
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To register the I/O table, double-click IO Table and Unit Setup.

Select Options > Create.

Click Yes at the I/O table creation prompt. Click Yes at the Initialize CPU bus settings 
prompt. Click Transfer at the transfer prompt. Click OK at the results prompt. The IO table 
will now be updated with the current PLC hardware settings.
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To edit the EtherNet/IP items and mapping, double-click the EtherNet/IP node.

Input the desired IP settings and then click Transfer [PC to Unit].

When prompted to transfer, click Yes. After the transfer prompt click Close. When 
prompted to restart the unit click Yes. Once the unit resets, click OK at the prompt. Close 
the IO edit dialog.

Physically power down the unit and adjust the rotary switches to match the last octet of the 
new IP address from above. Then power the unit back on.
CS50 Software Industrial Protocol Manual 7-5
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Set the CX-Programmer application to offline by selecting PLC > Work Offline or the 
online icon in the ribbon.

In the CX-Programmer application, double-click the PLC node. In the Network Type menu, 
select EtherNet/IP. Click Settings to the right of Network Type and enter the PLC’s new IP 
address. Click the OK buttons to close the dialogs.

Set the CX-Programmer back to online. You will be prompted with a connection via 
EtherNet/IP. Click Yes to complete the connection.

Double-click the IO Table and Unit Setup node. Expand the Built-In Port/Inner Board 
node. Right-click and select Start Special Application > Start with Settings Inherited.
7-6 CS50 Software Industrial Protocol Manual
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Select Network Configurator and click OK. Select port TCP:2 and click OK. Then click 
OK for EtherNet/IP_1 connection.

To install the EDS file, select EDS File > Install. Navigate to the EDS folder C:\di-
soric\Vscape\Firmware\eds\CS50. Select the correct file and click Open to load the file. 
All other EDS files can be downloaded from www.di-soric.com.

Expand the left tree view to open the OMRON Corporation files. Locate CJ2M-EIP21 for 
this example and drag it to the line in the right pane.
CS50 Software Industrial Protocol Manual 7-7
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Expand the Vendor Collection node for the camera connected to the PLC and drag it to 
the line in the right pane.

Right-click near the newly-added icons and select Change IP Address. Enter the IP 
address for the PLC and the camera or reader attached and click OK.

Double-click the PLC icon to edit the device parameters. This is where you will be linking 
and mapping the EtherNet/IP assembly data to the internal memory of the PLC. Select the 
Tag Sets tab. Select the In - Consume tab at the top. Click Edit Tags below. Then click 
New to edit/create a new tag. In this example we are naming this tag 300 for the 
peripheral memory linked to the input data. Select the size (320 bytes) for the entire input 
assembly. Click Regist then Close to continue.
7-8 CS50 Software Industrial Protocol Manual
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Select the Out - Produce tab and then click New. For the output assembly you are going 
to map to peripheral memory address 500 with 320 bytes. Click Regist and then Close. 
Click OK on the Edit Tags dialog. When prompted to register new tags click Yes.

Click the Connections tab on the Edit Device Parameters dialog. Click the download 
button in the middle to register the device.
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In the lower pane, double-click the PLC in the registered device list. This will open the 
linking dialog. If there are multiple connection types, they can be selected from the 
Connection I/O Type menu. In the Originator Device section, select the Input Tag then 
the Output Tag. Adjust the RPI if needed. When done, click Regist and then Close.

The registered device will now display the tags that are linked. Click OK to continue.
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Download the new tags and links to the PLC by selecting Device > Parameter > Download 
or by clicking the download icon in the ribbon. Click Yes when prompted to download.

When the List of Devices That Are Executing dialog appears, select the PLC and click 
Download after Changed to Program Mode. When prompted to return the state, click 
Yes to continue.

Select Network > Check Connection in the Network Configurator to ensure that there 
are no connection problems.
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CHAPTER 8 Using PROFINET I/O

This section provides information necessary for using the CS50 Sensor in 
a PROFINET I/O environment.

Notes: 

• The camera communications protocol must be enabled for PROFINET
I/O before it can be used in this environment. Refer to Chapter 1,
Enabling Industrial Protocols, for information about enabling
communications protocols for the CS50 Sensor, and information about
switching CS50 Sensor communications protocols.

• CS50 Software jobs use di-soric Link functionality to accommodate
PROFINET I/O communications between the camera and the PLC. For
information about how to connect job parameters and outputs to di-soric
Link tags, refer to the di-soric Link section of CS50 Software Help.

Important: PROFINET I/O allows the IP address and subnet mask of
the CS50 Sensor to be assigned automatically by the PLC. In order to
allow this, the CS50 Sensor may not have an assigned IP address on
reboot until the PLC is set to Run mode. During this time, the CS50
Sensor will not be visible on the network for CS50 Software.
CS50 Software Industrial Protocol Manual 8-1



Chapter 8 Using PROFINET I/O
CS50 Sensor PROFINET I/O

PROFINET I/O Identity

Vendor ID

di-soric’s Vendor ID is 0x221.

Device ID

The Device ID is 0x7000.

Connection Properties: RT Cyclic Messaging
Odd slot numbers are input to the PLC, even slot numbers are output from the PLC.

Maximum data size in either direction is 518 bytes. The data size can be reduced by 
removing slots that are not used.

Cycle update time: 16ms

Slot/Subslot Layout Descriptions
8-2 CS50 Software Industrial Protocol Manual
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Slot Data Layout Diagrams
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Chapter 8 Using PROFINET I/O
STEP 7 PLC Slot Layout
8-8 CS50 Software Industrial Protocol Manual
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Status: Camera Status Register (16-bit)

Each bit of this register represents a signal that displays the camera’s operational status. 
A high value of 1 indicates that the signal is active (true).
CS50 Software Industrial Protocol Manual 8-9



Chapter 8 Using PROFINET I/O
8-10 CS50 Software Industrial Protocol Manual

CmdCodeRslt (32-bit)

The value of CmdCodeRslt is only valid when ExeCmdAck is active (1), in response to 
ExeCmd being active.

CmdRet (32-bit)

The value of CmdRet is only valid when ExeCmdAck is active (1), in response to 
ExeCmd being active, and CmdCodeRslt is 0 (Success). The following chart shows 
which CmdCodes return data in the CmdRet register.
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State (16-bit)

State reflects the following operational condition of the camera:
CS50 Software Industrial Protocol Manual 8-11
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The value of State determines which Control and Status signals are available:
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VIO Output Register Bits

VIO Input Register Bits

Control: Camera Control Register (16-bit)

Each bit of this register controls a function on the camera. Transitions from a low state of 0 
to a high state of 1 initiate the associated operation. The PLC should return the state of the 
control bit back to 0 after it has acknowledged the camera has processed the control. 
Unused bits should remain 0.
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CmdCode and CmdArg (32-bit)

Specifies the process invoked in the camera when Control.ExeCmd goes active.

List of Available CmdCodes and Associated CmdArg

CmdCode and ExeCmd Operation



STEP 7 PLC Slot Layout

U
si

n
g

 P
R

O
F

IN
E

T
 I/

O

8

PROFINET I/O Control/Status Signal Operation
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CHAPTER 9 PROFINET I/O Blob Count 
Demo Using TIA Portal V13 
and CS50 Sensor

This section describes how to use di-soric demo PLC code with a vision job 
and camera target. The PROFINET I/O demo files can be found where 
CS50 Software is installed, in the folder: C:\di-soric\Tutorials and 
Samples\CS50 Sensor\PROFINET demo\TIAPortal_Demos\BlobDemo. 
Open Blob_Demo.avp with CS50 Software and download them to the camera.

Notes:

• The camera communications protocol must be enabled for
PROFINET I/O before it can be used in this environment. Refer to
Chapter 1, Enabling Industrial Protocols, for information about
enabling and switching communications protocols.

• CS50 Software jobs use di-soric Link functionality to accommodate
PROFINET I/O communications between the camera and the PLC.

Important: PROFINET I/O allows the IP address and subnet mask of the
camera to be assigned automatically by the PLC. In order to allow this,
the CS50 Sensor may not have an assigned IP address on reboot until
the PLC is set to Run mode. During this time, the CS50 Sensor will not be
visible on the network for CS50 Software.



Chapter 9 PROFINET I/O Blob Count Demo Using TIA Portal V13 and CS50 Sensor
Overview
In this demonstration, you will learn how to load a saved job into the camera, establish 
connectivity via PROFINET I/O to a Siemens ET200SP CPU PLC, and run some example 
programs that interface with the camera. While evaluating PROFINET I/O capabilities, you will:

• Begin with CS50 Software.

Open a sample demo vision job in CS50 Software and use the Try Out feature to learn 
what to expect from the camera before it is connected to the PLC.

• Prepare the PLC.

Integrate the camera into the PLC environment with TIA Portal software and the GSD file.

• Run the camera.

Trigger the camera while it is online with the PLC and observe changes in the Inspection 
status as the PLC reconfigures the vision job’s parameters. Prior to starting CS50 
Software, make sure the camera is either connected to the PLC or both PLC and camera 
are on the same physical network. Ensure that the PC, PLC, and camera have the same 
network class and corresponding subnet addresses. 

Open CS50 Software and select the camera.
9-2 AutoVISION and Visionscape Industrial Protocol User Manual
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From the Image view, click the Load a Job button. Then navigate to 
C:\di-soric\Vscape\Tutorials And Samples\CS50 Sensor\PROFINET 
demo\TIAPortal_Demos\BlobDemo. Select BlobDemo.avp. 

The demo job will include one tool: Count Blobs. 

The Blob tool data item linked to the PROFINET I/O structure as shown here:

This data is transferred cyclically between the camera and PLC.

Once the job has loaded, the next step is to link the pre-saved images on 
the local PC. On the Camera button, click the far left icon to select and 
load an image. 
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A file browser will open. Then navigate to the same folder where the demo job was loaded 
PROFINET I/O Demo. If the images are located, the icon will change from a camera to a folder. 

By clicking the Try Job Once icon, the application will cycle through the entire job with the 
loaded image. 

There are two images on file. One will pass the inspection and one will fail. 
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Now click the Run button on the top ribbon. This will download the job to the camera. At 
this point the job is ready to run and can be tested. However, in order to run the job 
change demo this job needs to be loaded into Slot 1. Click back to the Edit view from the 
top ribbon bar.

Click the slot icon and select Slot 1 or New Slot if no slots are currently in use. 

Now the job and images will be saved to the flash memory of the camera.
AutoVISION and Visionscape Industrial Protocol User Manual 9-5
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TIA Portal V13 Setup
This section was created using Siemens TIA Portal software version 13 and an ET200SP 
CPU catalog number 6ES7 510-1DJ01-0AB0, HW version 2, FW version 1.8.2. 

First launch the TIA Portal from the desktop.

Create a new project from the menu item Project->New. The default name is Project1 as 
seen below. Fill out the required information, then click Create. 
9-6 AutoVISION and Visionscape Industrial Protocol User Manual
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The screen below shows the main screen you will see when a project is opened.

Double-click Add new device. 
AutoVISION and Visionscape Industrial Protocol User Manual 9-7
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Open the SIMATIC ET200 CPU arrow, then open the ET200SP CPU arrow, then open the 
CPU 1510SP-1 PN, then click on 6ES7 510-1DJ01-0AB0. You will see the screen below. 
Click OK.
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You will see the following screen. 

Click the lower green box on the PLC picture. The following will be displayed in the lower pane. 

Click Add new subnet. The Subnet field will show PN/IE_1. Now go to the IP address 
field, and type the IP address you wish to use for this device. Click Save Project often to 
save your work.
AutoVISION and Visionscape Industrial Protocol User Manual 9-9
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To the right of the screen, you will see the following:

The modules in our test device are as follows:

1. DI 16x24VDC ST order number 6ES7 131-6BH00-0BA0

2. DQ 16x24VDC ST order number 6ES7 132-6BH00-0BA0

To add these modules, first click the arrow next to DI, keep clicking on arrows until you find 
the order number for device 1. Click and hold down the left mouse key. Drag it to slot 2 just 
to the left. 
9-10 AutoVISION and Visionscape Industrial Protocol User Manual
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Your display should look like this:

Do the same thing for device 2, looking under the DQ arrow. Your display should now look 
like this:

Now click on the PLC picture on slot 2. You will see the following screen:
AutoVISION and Visionscape Industrial Protocol User Manual 9-11
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Be sure the Enable new potential group (light Base Unit) is selected. Do the same for 
Slot 3. Save the project. 

Now click on Options->Manage general station description files (GSD). 

Browse to the following path: C:\di-soric\Vscape\Firmware\gsd\CS50 Sensor. Select the 
appropriate GSD file by clicking the box next to the name, and click Install.

Click the tab that says Network View:
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Look at the right panel and click Hardware Catalog. Use the arrows to open up the 
following area. Other field devices->PROFINET IO ->General->di-soric->Smart 
Camera->CS50 Sensor. Left-click on CS50 Sensor and hold it. Drag it to the left into the 
Devices and networks panel. Your screen will look like this:

On the CS50 Sensor picture, click the Not assigned link, then click on PLC_1.PROFINET 
IO-System. This has just connected the CS50 Sensor to the PROFINET network.
AutoVISION and Visionscape Industrial Protocol User Manual 9-13
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Double-click the picture of the CS50 Sensor. In the bottom pane you will see the following:

Enter the name of the device in the Name: field. Then click Ethernet addresses on the left, 
and type in the IP address of the camera. This will allow the PLC to set the camera IP.
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Importing an Example Program
From TIA Portal, open the example program from the menu Project > Open. Click the 
Browse button to locate the (BlobDemo.ap13) program. The BlobDemo is located in 
C:\di-soric\Vscape\Tutorials and Samples\CS50 Sensor\PROFINET 
Demo\TIAPortal_Demos\BlobDemo. In the left pane in the Devices tab, open the 
PLC_1[CPU 1510SP-1 PN] arrow. Open the Program blocks arrow. Select all the blocks 
as shown below.
AutoVISION and Visionscape Industrial Protocol User Manual 9-15
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Right-click and copy. Go to your new project and open the same arrows, right-click on 
Program blocks, then click paste. Be sure to save your work. You may need to delete the 
Main [OB1] in the new project first.

Now back in the left pane of the BlobDemo project, click on PLC data types, right-click, 
copy, and paste them into the new project PLC data types.

In the left pane of the BlobDemo project, click on Watch and force tables. Right-click on 
Watch table_1, then copy. Paste into new project Watch and force tables. Be sure to save 
the project.

Your data in the new project should look like this:
9-16 AutoVISION and Visionscape Industrial Protocol User Manual
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Checking the Mapping of IO
Depending on the order the PLC can load things, we may need to change the IO 
addresses in our block to match the Device Overview in the Device view screen.

Double-click on the CS50 Sensor picture, and the Device overview will be displayed to the right.

The image below is intended as an example only and may not exactly resemble your 
Device Overview.

From the Hardware catalog display to the far right, open the Module selection. You will 
see the following:
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You must manually drag and drop “Int In” into the Device Overview pane. Click “Int In” and 
TIA will highlight the slot to drag it to. TIA will only allow you to insert them into their proper 
slot position.

Your device view should now look as follows. The example addresses shown will not be 
the same for your device.
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You need to modify the PLC program blocks to agree with this display. On the left under the 
Devices pane, open the Program blocks arrow, and double-click on OB1 [OB1]. This will 
open a screen in the middle pane. Scroll this middle pane down until you see Network 1.

Change the numbers here to match with the Device overview display, as shown in the 
example below. Leave the DB_Number as is. 

Repeat this for Network 4, using the Int In_1 address from the Device Overview and put it 
in the INT_ADDR below. Leave the DB_Number as is.

Be sure to save the project. Click the PLC_1 {CPU 1510SP-1 PN] top level, then click the 
compile icon. 

There should be NO compile errors. If there are no errors, click the download icon. 
AutoVISION and Visionscape Industrial Protocol User Manual 9-19
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You will see the following screen:
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Select your PC network interface, and change the Connection to interface/subnet to PN/IE_1. 
Click Start Search. PLC_1 should be displayed with the address you gave it. Click Load. If you 
see a screen similar to below, do a memory reset (MRES) on the PLC, and try to load again. If 
this continues to be an issue, click Continue without synchronization and continue.

When downloading is working correctly you will see the following: 
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All LEDS on the PLC should be GREEN. Click Go online. You should see the following:
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Troubleshooting
If all LEDs are not green, go offline and click the Accessible devices icon.

Click Start search. The PLC and the CS50 Sensor should be displayed here. 

If the name of the CS50 Sensor is not correct, you will not connect. The default name is 
cs50 with the last 3 of the MAC address. Ex: cs50186c49. Go back to the general settings 
of the CS50 Sensor in the device view, and change the name if required. Re-compile, and 
re-load. Try running again. This is the most common reason for not connecting.
AutoVISION and Visionscape Industrial Protocol User Manual 9-23
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Running the Demo
In the left pane click the Watch and force tables arrow. Double-click Watch table_1. The 
watch table will open in the center pane. Click on the monitor variables icon. 

The following operations can be tried here:
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Change Jobs + Get Current Job Slot

Be sure to store a job in a slot in the camera memory as described earlier. To execute this 
test properly, load another job into Slot 2 of the camera. For example, the 
Circle_LocatorDemo job. CS50 Software must be closed to run this demo.

Go to Watch table_1, and click the button with the glasses and “play” symbol. This begins 
the monitoring of data.

Using the Watch table_1 elements ChangeJob and New_JobSlot, click on the Modify 
Value column next to New_JobSlot, type 2, type Enter. Click on the Modify value to the 
right of ChangeJob and enter TRUE. Click on the lightning bolt with a 1 at the top. This will 
set the job slot to 2. Then click the lightning bolt button again.
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The current job will be changed to the job in slot 2. To verify that this clears all changes 
made to the Modify value column, click on Modify value to the right of 
Get_CurrentJobSlot. Enter TRUE, and click on the lightning bolt button again.

You will see the current job listed to the right of Current_JobSlot. You can repeat this 
procedure changing the slot back to 1 and verify that the current job slot is now 1.

Trigger an Inspection and Reset Counters

Clear any changes made to the Modify value column. If you want to watch the inspection, 
be sure CS50 Software is running and connected to the device. Be sure the job is running. 
If you choose not to run CS50 Software, you can look at the LEDs on the device to confirm 
your triggers. Change the value to the right of Trigger to be TRUE, and click the lightning 
bolt button again.

You will see the NumberOfParts change to either 2 or 5. The pass and fail bools will 
indicate whether the inspection has passed or failed. Also, the appropriate counters will 
have incremented. Each click of the lightning bolt button will cause an inspection, which 
will bounce from one image to the next. One will pass and the next will fail.
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To reset the counters, clear all settings in the Modify value column, and change the one 
next to ResetCounters to TRUE, and click the lightning bolt button again. You will see all 
the counters in blue reset to 0.

If you clear this again, set the Trigger to TRUE, and click the lightning bolt button again, you 
will notice that the counts start at 1 on both the PLC counters and CS50 Software counters. 

Reset Error

If at any time there is an error indicated by a TRUE in any of the values below, you can 
clear the error by entering a TRUE to the right of ResetError and clicking the lightning 
button. Reset it to FALSE and click the button again. Any errors in the values below 
should be cleared.
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CHAPTER 10 PROFINET I/O Circle Locate 
Demo Using TIA Portal V13 
and CS50 Sensor

This section describes how to use di-soric demo PLC code with a vision job 
and camera target. The PROFINET I/O demo files can be found where 
CS50 Software is installed, in the folder: C:\di-soric\Tutorials and 
Samples\CS50 Sensor\PROFINET demo\ TIAPortal_Demos\ 
Circle_LocateDemo. Open Circle_LocatorDemo.avp with CS50 
Software and download it to the camera.

Notes:

• The camera communications protocol must be enabled for
PROFINET I/O before it can be used in this environment. Refer to
Chapter 1, Enabling Industrial Protocols, for information about
enabling and switching communications protocols.

• CS50 Software jobs use di-soric Link functionality to accommodate
PROFINET I/O communications between the camera and the PLC.

Important: PROFINET I/O allows the IP address and subnet mask of
the camera to be assigned automatically by the PLC. In order to allow
this, the CS50 Sensor may not have an assigned IP address on
reboot until the PLC is set to Run mode. During this time, the CS50
Sensor will not be visible on the network for CS50 Software.
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Overview
In this demonstration, you will learn how to load a saved job into the camera, establish 
connectivity via PROFINET I/O to a Siemens ET200SP CPU PLC, and run some example 
programs that interface with the camera. While evaluating PROFINET I/O capabilities, you will:

• Begin with CS50 Software.

Open a sample demo vision job in CS50 Software and use the Try Out feature to learn 
what to expect from the camera before it is connected to the PLC.

• Prepare the PLC.

Integrate the camera into the PLC environment with TIA Portal software and the GSD file.

• Run the camera.

Trigger the camera while it is online with the PLC and observe changes in the Inspection 
status as the PLC reconfigures the vision job’s parameters. Prior to starting CS50 
Software, make sure the camera is either connected to the PLC or both PLC and camera 
are on the same physical network. Ensure that the PC, PLC, and camera have the same 
network class and corresponding subnet addresses. 

Open CS50 Software and select the camera.
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From the Image view, click the Load a Job button. Then navigate to 
C:\di-soric\Vscape\Tutorials And Samples\CS50 Sensor\PROFINET 
demo\TIAPortal_Demos\Circle_LocatorDemo. Select 
Circle_LocatorDemo.avp. 

The demo job will include two tools: Locate Shape and Circle. 

The PROFINET I/O structure is shown here:

This data is transferred cyclically between the camera and PLC.
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Once the job has loaded, the next step is to link the pre-saved images on the local PC. On 
the Camera button, click the far left icon to select and load an image. 

A file browser will open. Then navigate to the same folder where the demo job was loaded 
PROFINET I/O Demo. If the images are located, the icon will change from a camera to a folder. 

By clicking the Try Job Once icon, the application will cycle through the entire job with the 
loaded image. 
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There are two images on file. One will pass the inspection and one will fail. 
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Now click the Run button on the top ribbon. This will download the job to the camera. At 
this point the job is ready to run and can be tested. However, in order to run the job 
change demo this job needs to be loaded into Slot 1. Click back to the Edit view from the 
top ribbon bar.

Click the slot icon and select Slot 1 or New Slot if no slots are currently in use. 

Now the job and images will be saved to the flash memory of the camera.
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TIA Portal V13 Setup
This section was created using Siemens TIA Portal software version 13 and an ET200SP 
CPU catalog number 6ES7 510-1DJ01-0AB0, HW version 2, FW version 1.8.2. This 
example shows the CS50 Sensor device. However, the steps are similar for any device.

First launch the TIA Portal from the desktop.

Create a new project from the menu item Project->New. The default name is Project1 as 
seen below. Fill out the required information, then click Create. 
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The screen below shows the main screen you will see when a project is opened.

Double-click Add new device. 
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Open the SIMATIC ET200 CPU arrow, then open the ET200SP CPU arrow, then open the 
CPU 1510SP-1 PN, then click on 6ES7 510-1DJ01-0AB0. You will see the screen below. 
Click OK.
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You will see the following screen. 

Click the lower green box on the PLC picture. The following will be displayed in the lower pane. 

Click Add new subnet. The Subnet field will show PN/IE_1. Now go to the IP address 
field, and type the IP address you wish to use for this device. Click Save Project often to 
save your work.
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To the right of the screen, you will see the following:

The modules in our test device are as follows:

1. DI 16x24VDC ST order number 6ES7 131-6BH00-0BA0

2. DQ 16x24VDC ST order number 6ES7 132-6BH00-0BA0

To add these modules, first click the arrow next to DI, keep clicking on arrows until you find 
the order number for device 1. Click and hold down the left mouse key. Drag it to slot 2 just 
to the left. 
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Your display should look like this:

Do the same thing for device 2, looking under the DQ arrow. Your display should now look 
like this:

Now click on the PLC picture on slot 2. You will see the following screen:
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Be sure the Enable new potential group (light Base Unit) is selected. Do the same for 
Slot 3. Save the project. 

Now click on Options->Manage general station description files (GSD). 

Browse to the following path: C:\di-soric\Vscape\Firmware\gsd\CS50 Sensor. Select the 
appropriate GSD file by clicking the box next to the name, and click Install.

Click the tab that says Network View:
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Look at the right panel and click Hardware Catalog. Use the arrows to open up the 
following area. Other field devices->PROFINET IO ->General->di-soric->Smart 
Camera->CS50 Sensor. Left-click on CS50 Sensor and hold it. Drag it to the left into the 
Devices and networks panel. Your screen will look like this:

On the CS50 Sensor picture, click the Not assigned link, then click on PLC_1.PROFINET 
IO-System. This has just connected the CS50 Sensor to the PROFINET network.
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Double-click the picture of the CS50 Sensor. In the bottom pane you will see the following:

Enter the name of the device in the Name: field. Then click Ethernet addresses on the left, 
and type in the IP address of the camera. This will allow the PLC to set the camera IP.
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Importing an Example Program
From TIA Portal, open the example program from the menu Project > Open. Click the 
Browse button to locate the (Circle_LocatorDemo.ap13) program. The 
Circle_LocatorDemo is located in C:\di-soric\Vscape\Tutorials and Samples\CS50 
Sensor\PROFINET Demo\ TIAPortal_Demos\Circle_LocatorDemo\ 
TIACircle_LocatorDemo. In the left pane in the Devices tab, open the PLC_1[CPU 
1510SP-1 PN] arrow. Open the Program blocks arrow. Select all the blocks as shown below.
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Right-click and copy. Go to your new project and open the same arrows, right-click on 
Program blocks, then click paste. Be sure to save your work. You may need to delete the 
Main [OB1] in the new project first.

Now back in the left pane of the Circle_LocatorDemo project, click on PLC data types, 
right-click, copy, and paste them into the new project PLC data types.

In the left pane of the Circle_LocatorDemo project, click on Watch and force tables. Right-
click on Watch table_1, then copy. Paste into new project Watch and force tables. Be sure 
to save the project.

Your data in the new project should look like this:
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Checking the Mapping of IO
Depending on the order the PLC can load things, we may need to change the IO 
addresses in our block to match the Device Overview in the Device view screen.

Double-click on the CS50 Sensor picture, and the Device overview will be displayed to the right.

The image below is intended as an example only and may not exactly resemble your 
Device Overview.

From the Hardware catalog display to the far right, open the Module selection. You will 
see the following:
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You must manually drag and drop “Boolean In_1” and “Float In_1” into the Device 
Overview pane. Click on “Boolean In_1”, and TIA will highlight the slot to drag it to. Repeat 
this for “Float In_1”. TIA will only allow you to insert them into their proper slot position.

Your device view should now look as follows. The example addresses shown will not be 
the same for your device.
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You need to modify the PLC program blocks to agree with this display. On the left under the 
Devices pane, open the Program blocks arrow, and double-click on OB1 [OB1]. This will 
open a screen in the middle pane. Scroll this middle pane down until you see Network 1. 

Change the numbers here to match with the Device overview display, as shown in the 
example below. Leave the DB_Number as-is.

Repeat this for Network 4, using the Boolean In_1 address and the Float In_1address 
from the Device Overview and put it in the BOOL_ADDR and FLOAT_ADDR respectively. 
Leave the DB_Number as-is.



Overview

P
R

O
F

IN
E

T
 I/

O
 C

ir
cl

e 
L

o
ca

te
 D

em
o

10
AutoVISION and Visionscape Industrial Protocol User Manual 10-21

Be sure to save the project. Click the PLC_1 {CPU 1510SP-1 PN] top level, then click the 
compile icon. 

There should be NO compile errors. If there are no errors, click the download icon. 

You will see the following screen:
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Select your PC network interface, and change the Connection to interface/subnet to PN/IE_1. 
Click Start Search. PLC_1 should be displayed with the address you gave it. Click Load. If you 
see a screen similar to below, do a memory reset (MRES) on the PLC, and try to load again. If 
this continues to be an issue, click Continue without synchronization and continue.

When downloading is working correctly you will see the following: 
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All LEDS on the PLC should be GREEN. Click Go online. You should see the following:
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Troubleshooting
If all LEDs are not green, go offline and click the Accessible devices icon.

Click Start search. The PLC and the CS50 Sensor should be displayed here. 

If the name of the CS50 Sensor is not correct, you will not connect. The default name is 
cs50 with the last 3 of the MAC address. Ex: cs50186c49. Go back to the general settings 
of the CS50 Sensor in the device view, and change the name if required. Re-compile, and 
re-load. Try running again. This is the most common reason for not connecting.
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Running the Demo
In the left pane click the Watch and force tables arrow. Double-click Watch table_1. The 
watch table will open in the center pane. Click on the monitor variables icon. 

The following operations can be tried here:
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Change Jobs + Get Current Job Slot

Be sure to store a job in a slot in the camera memory as described earlier. To execute this 
test properly, load another job into Slot 2 of the camera. For example, the BlobDemo job. 
CS50 Software must be closed to run this demo.

Go to Watch table_1, and click the button with the glasses and “play” symbol. This begins 
the monitoring of data.

Using the Watch table_1 elements ChangeJob and New_JobSlot, click on the Modify 
Value column next to New_JobSlot, type 2, and type Enter. Click on the Modify value to 
the right of ChangeJob and enter TRUE. Click on the lightning bolt with a 1 at the top. This 
will set the job slot to 2. Then click the lightning bolt button again.
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The current job will be changed to the job in slot 2. To verify that this clears all changes 
made to the Modify value column, click on Modify value to the right of 
Get_CurrentJobSlot. Enter TRUE, and click on the lightning bolt button again.

You will see the current job listed to the right of Current_JobSlot. You can repeat this 
procedure, changing the slot back to 1 and verify that the current job slot is now 1.

Trigger an Inspection and Reset Counters

Clear any changes made to the Modify value column. If you want to watch the inspection, 
be sure CS50 Software is running and connected to the device. Be sure the job is running. 
If you choose not to run CS50 Software, you can look at the LEDs on the device to confirm 
your triggers. Change the value to the right of Trigger to be TRUE, and click the lightning 
bolt button again.

You will see the InstancePoints, Status, and RadiusDatum change based on the picture. 
The pass and fail bools will indicate whether the inspection has passed or failed. Also, the 
appropriate counters will have incremented. Each click of the lightning bolt button will 
cause an inspection which will bounce from one image to the next. One will pass and the 
next will fail.
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To reset the counters, clear all settings in the Modify value column, and change the one 
next to ResetCounters to TRUE, and click the lightning bolt button again. You will see all 
the counters in blue reset to 0.

If you clear this again, set the Trigger to TRUE, and click the lightning bolt button again, you 
will notice that the counts start at 1 on both the PLC counters and CS50 Software counters. 

Reset Error

If at any time there is an error indicated by a TRUE in any of the values below, you can 
clear the error by entering a TRUE to the right of ResetError and clicking the lightning bolt 
button. Reset it to FALSE and click the button again. Any errors in the values below 
should be cleared.
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CHAPTER 11 PROFINET I/O Blob Count 
Demo Using STEP 7 and 
CS50 Sensor

This section describes how to use di-soric demo PLC code with a vision 
job and camera target. 

The PROFINET I/O demo files can be found where CS50 Software is 
installed, in the folder: C:\di-soric\Vscape\Tutorials and Samples\ 
CS50 Sensor\PROFINET Demo\Step7_Demos\BlobDemo. Open 
BlobDemo.avp and download it to the camera.

Notes:

• The camera communications protocol must be enabled for
PROFINET I/O before it can be used in this environment. Refer to
Chapter 1, Enabling Industrial Protocols, for information about
enabling and switching communications protocols.

• CS50 Software jobs use di-soric Link functionality to accommodate
PROFINET I/O communications between the camera and the PLC.

Important: PROFINET I/O allows the IP address and subnet mask of the
camera to be assigned automatically by the PLC. In order to allow this,
the CS50 Sensor may not have an assigned IP address on reboot until
the PLC is set to Run mode. During this time, the CS50 Sensor will not be
visible on the network for CS50 Software.
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Overview

In this demonstration, you will learn how to load a saved job into the 
camera, establish connectivity via PROFINET I/O to a Siemens S7 PLC, 
and run some example programs that interface with the camera.

While evaluating PROFINET I/O capabilities, you will:

• Begin with CS50 Software.

Open a sample demo vision job in CS50 Software and use the Try Out 
feature to learn what to expect from the camera before it is connected to 
the PLC.

• Prepare the PLC.

Integrate the camera into the PLC environment with STEP 7 software and 
the GSD file.

• Run the camera.

Trigger the camera while it is online with the PLC and observe changes in 
the Inspection status as the PLC reconfigures the vision job’s parameters.
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CS50 Software Setup

Prior to starting CS50 Software, make sure the camera is either connected to the PLC or 
both PLC and camera are on the same physical network. Ensure that the PC, PLC, and 
camera have the same network class and corresponding subnet addresses.

Open CS50 Software and select the camera.

From the Image view, click the Load a Job button. Then navigate to C:\di-soric\ 
Vscape\Tutorials And Samples\CS50 Sensor\PROFINET Demo\Step7_Demos\ 
BlobDemo. Select BlobDemo.avp.

The demo job will include one tool: Count Blobs. 
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The Blob tool data item linked to the PROFINET I/O structure as shown here:

This data is transferred cyclically between the camera and PLC.

Once the job has loaded, the next step is to link the pre-saved images on the local PC. On 
the Camera button, click the far left icon to select and load an image. 

A file browser will open. Then navigate to the same folder where the demo job was loaded 
PROFINET I/O Demo. If the images are located, the icon will change from a camera to a folder. 

By clicking the Try Job Once icon, the application will cycle through the entire job with the 
loaded image. 
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There are two images on file. One will pass the inspection and one will fail. 

Now click the Run button on the top ribbon. This will download the job to the camera. At 
this point the job is ready to run and can be tested. However, in order to run the job 
change demo this job needs to be loaded into Slot 1. Click back to the Edit view from the 
top ribbon bar.

Click the slot icon and select Slot 1 or New Slot if no slots are currently in use. 

Now the job and images will be saved to the flash memory of the camera.
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STEP 7 Setup
This section was created using Siemens STEP 7 software version 5.5 + 
SP2 and an ET200S PLC, catalog number 6ES7 151-8AB01-0AB0, CPU 
Version 3.2. It was tested with a 315-2 PN/DP PLC, catalog number 
6ES7-315-2EH13-0AB0, CPU Version 2.6.

First launch the SIMATIC Manager from the desktop.

Create a new project from the menu item File > New. Select the project 
location on disk then enter the name and click the OK button. In the 
example below, the name is Start. Once the project is first created, you 
will see the dialog. This dialog is the main entry point into the PLC 
program and hardware settings.
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The PC may have multiple network cards so it’s imperative to map the 
correct one to the SIMATIC software. From the menu, select Options > 
Set PG/PC Interface. This will open the Set PG/PC Interface dialog and 
list the available network cards. On the Access Path tab select the NIC 
card with (TCP/IP >) in the name.

In the SIMATIC Manager dialog, right-click and select Insert New Object. 
This is where you will select the base station. For example, when 
configuring an ET200-s, select SIMATIC 300 Station since it’s based on 
the 300 series CPU.
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After the station has been added, right-click and add Industrial Ethernet.

Expand the Start tree node on the left pane and click the station. On the 
right pane you will see a Hardware icon.
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Double-click the Hardware icon to launch the HW Config dialog.

Make sure the Catalog is selected in the ribbon bar on the top. This will 
add a tree view on the right pane with all the available hardware devices.

If the latest GSDML file hasn’t been imported, follow the next steps to 
import.

GSDML

• Install the GSD file from the menu item Options > Install GSD File.

• Click the Browse button to locate the GSDML file \di-soric\ 
Vscape\Firmware\gsd\CS50 Sensor.
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• The center pane will list the available GSDML files.

• Select the file and click the Install button.

• When finished, close the dialog.

• The camera should now be present in the PROFINET I/O section 
under Additional Field Devices > General.
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Add the CPU from the catalog view by drag and drop or double-click. 
Make sure the catalog number and version matches the PLC exactly. 
The catalog number will be displayed on the bottom of the view.

Some CPUs are modules that will require a generic rack to be added 
prior. If your PLC requires a rack, you will be prompted to add the 
rack prior to being allowed to insert the CPU module.

After the CPU is added, a popup dialog will prompt the Properties 
relating to the IP information.
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Select Ethernet(1) on the bottom list box and enter the correct IP address of the CPU.

Once the CPU has been added, add any additional expansion modules, if installed. Click 
the CPU on the left pane and the bottom pane will list the available ports and slots.

Add the camera in the location (PROFINET I/O > Additional Field Devices > General > 
di-soric). The camera can be added by drag and drop to Ethernet(1): PROFINET-I/O 
System (100) or by selecting the Ethernet(1) line first and double-clicking the camera. 
Once the camera has been added the icon will appear on the configuration dialog.
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Once the camera has been added, double-click the icon to open the 
properties dialog. Under the device name, enter the existing name of the 
camera or a unique name.

If a unique name is used, the device has to be manually updated. View 
Updating camera name section.
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Click the camera icon and the data slot address mapping will be displayed below. Take 
note of the address values since they will be needed in the demo application. Since there 
is an infinite combination of modules and slot configurations, the addressing is unique to 
every setup.
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This demo uses the Int In data. To the right under PROFINET I/O CS50 Sensor, click Int 
In. This will highlight its appropriate slot. Drag and drop this highlighted slot. The table 
should resemble the following:
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Once the hardware configuration has been completed, it’s time to compile and download. 
Click the compile and save icon on the ribbon. If there are any configuration conflicts, the 
application will prompt a warning at this point.

Once compiled, click the download icon on the ribbon to send the information to the PLC.

At this point close or minimize the HW Config dialog and re-visit the SIMATIC Manager 
dialog. The CPU should be added next to the Hardware icon and in the tree view in the left 
pane. Expand the CPU tree item and remaining child items below it.

Click the Blocks node to view the program objects.
11-16 AutoVISION and Visionscape Industrial Protocol User Manual



STEP 7 Setup

P
R

O
F

IN
E

T
 I/

O
 B

lo
b

 
C

o
u

n
t 

D
em

o

11
AutoVISION and Visionscape Industrial Protocol User Manual 11-17

Updating Camera Name 

From the HW Config dialog open Edit Ethernet Node from the menu item PLC > 
Ethernet > Edit Ethernet Node. From the SIMATIC Manager dialog open Edit Ethernet 
Node from the menu item PLC > Edit Ethernet Node.

Click the Browse button to open the node selection dialog.

Select the camera and click the OK button.

Edit the Device Name, if necessary, to match the name entered previously in the CS50 
Sensor properties dialog, and click the Assign Name button.
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Importing Example Program
From the SIMATIC Manager, open the example program from the menu File > Open. 
Click the Browse button to locate the (BlobDemo) program. The BlobDemo is located in 
\di-soric\Vscape\Tutorials and Samples\CS50 Sensor\PROFINET Demo\ 
Step7_Demos\BlobDemo\S7BlobDemo\BlobDemo.s7p.

Split both example and current projects in the dialog as shown.

Select the objects minus the System data object and copy with a right-click and Copy or 
CTRL + C. Paste into the current project with a right-click > paste or CTRL + V. When 
prompted that OB1 already exists, click the Yes button to overwrite it. Now the example 
program is imported to the current project.
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Select the Blocks icon on the left pane. Then click the download button on the top ribbon. 
This will download the new copied functions and system data to the PLC. Now it’s time to 
update the new addressing from the hardware installation prior. Double-click the OB1 
block to open the LAD/STL/FBD editor. OB1 is the main routine of the PLC program.
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Scroll down to Network 1. This is where the data is mapped from the camera to the local 
data structure. FC1 is a function that pushes the input data from the camera to the 
program structure. Click the numbers to match the address on the hardware as shown. 
Click the following buttons on the popup dialogs:
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Note: This is the address mapping view of the CS50 Sensor module which is derived from 
the hardware config view. 

The addresses on the right must be copied to Network 1 to match. Ex: HW config shows 
Status as address 0..1. Copy 0 into Network 1, STATUS value.

Repeat the same steps for Network 6 to update the output data mapping. Keep in mind 
that all input addresses are under the (I address) column and the output addresses are 
under the (Q address) column. Save to the PC and download to the PLC.

Do a master reset and set the PLC to RUN mode. Make sure all LEDs indicate good.
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Running the Demo

In the SIMATIC Manager dialog, double-click the VAT_1 icon. This will open the variable 
table dialog for the data type demo. Maximize the internal dialog to increase the viewing area.

To establish a live connection to the PLC, click the Monitor Variable button on the ribbon. 
This will update data from the PLC to the dialog. The top title bar will go blue and the 
bottom status will show run with a green progress bar.
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The following operations can be tried here:

Change Jobs + Get Current Job Slot

Be sure to follow instructions in the CS50 Software Setup section to store a job in a slot in 
the camera memory. To properly execute this test, load another job into slot 2 of the 
camera. For example, the Circle_LocatorDemo job. CS50 Software must be closed to run 
this Demo.

Using the VAT_1 elements ChangeJob and New_JobSlot. Click the Modify value 
column next to New_JobSlot, type 2, and type Enter. Click on the Modify Value column to 
the right of ChangeJob and enter TRUE. Click on the icon indicated at the top.

The current job will be changed to the job in slot 2. To verify this, clear all changes made 
to the Modify value column, and click Modify value to the right of Get_CurrentJobSlot. 
Enter TRUE, and click on the indicated icon again.

You will see the current job listed to the right of Current_JobSlot. You may repeat this 
procedure changing the slot back to 1 and verify the current job slot is now 1.
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Trigger Inspection and Reset Counters

Be sure the current job selected is slot 1. Clear any changes made to the Modify value 
column. If you want to watch the inspection, be sure CS50 Software is running, and 
connected to the device. Be sure the job is running. If you choose not to run CS50 
Software, you may look at the LEDs on the device to confirm your triggers. Change the 
value to the right of Trigger to TRUE, and click the indicated icon. 

You will see the NumberOfParts change to either 2 or 5. The pass and fail bools will 
indicate whether the inspection has passed or failed. Also, the appropriate counters will 
have incremented. Each press of the icon will cause an inspection which will bounce from 
one image to the next. One will pass and the next will fail. 
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Reset Counters

To reset the counters, clear all settings in the Modify value column, and change the one 
next to ResetCounters to TRUE, and click the icon again. You will see all the counters in 
blue reset to 0.

If you clear this again and set the Trigger to TRUE, and click the lightning bolt button again, you 
will notice that the counts start at 1 on both the PLC counters and CS50 Software counters. 

Reset Error

If at any time there is an error indicated by a TRUE in any of the values below, you can 
clear the error by entering a TRUE to the right of ResetError and clicking the icon. Reset 
it to FALSE and click the button again. Any errors in the values below should be cleared.
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CHAPTER 12 PROFINET I/O Circle 
Locate Demo Using STEP 7 
and CS50 Sensor

This section describes how to use di-soric demo PLC code with a vision 
job and camera target. 

The PROFINET I/O demo files can be found where CS50 Software is 
installed, in the folder: C:\di-soric\Vscape\Tutorials and Samples\ 
CS50 Sensor\PROFINET Demo\Step7_Demos\Circle_LocatorDemo. 
Open Circle_LocatorDemo.avp and download it to the camera.

Notes:

• The camera communications protocol must be enabled for
PROFINET I/O before it can be used in this environment. Refer to
Chapter 1, Enabling Industrial Protocols, for information about
enabling and switching communications protocols.

• CS50 Software jobs use di-soric Link functionality to accommodate
PROFINET I/O communications between the camera and the PLC.

Important: PROFINET I/O allows the IP address and subnet mask of the
camera to be assigned automatically by the PLC. In order to allow this,
the CS50 Sensor may not have an assigned IP address on reboot until
the PLC is set to Run mode. During this time, the CS50 Sensor will not be
visible on the network for CS50 Software.
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Overview

In this demonstration, you will learn how to load a saved job into the 
camera, establish connectivity via PROFINET I/O to a Siemens S7 PLC, 
and run some example programs that interface with the camera.

While evaluating PROFINET I/O capabilities, you will:

• Begin with CS50 Software.

Open a sample demo vision job in CS50 Software and use the Try Out 
feature to learn what to expect from the camera before it is connected to 
the PLC.

• Prepare the PLC.

Integrate the camera into the PLC environment with STEP 7 software and 
the GSD file.

• Run the camera.

Trigger the camera while it is online with the PLC and observe changes in 
the Inspection status as the PLC reconfigures the vision job’s parameters.
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CS50 Software Setup

Prior to starting CS50 Software, make sure the camera is either connected to the PLC or 
both PLC and camera are on the same physical network. Ensure that the PC, PLC, and 
camera have the same network class and corresponding subnet addresses.

Open CS50 Software and select the camera.

From the Image view, click the Load a Job button. Then navigate to C:\di-
soric\Vscape\Tutorials And Samples\CS50 Sensor\PROFINET demo\Step7_Demos\ 
Circle_LocatorDemo. Select Circle_LocatorDemo.avp. 

The demo job will include two tools: Locate Shape and Circle. 
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The PROFINET I/O structure is shown here:

This data is transferred cyclically between the camera and PLC.

Once the job has loaded, the next step is to link the pre-saved images on the local PC. On 
the Camera button, click the far left icon to select and load an image. 

A file browser will open. Then navigate to the same folder where the demo job was loaded 
PROFINET I/O Demo. If the images are located, the icon will change from a camera to a folder. 

By clicking the Try Job Once icon, the application will cycle through the entire job with the 
loaded image. 
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There are two images on file. One will pass the inspection and one will fail. 
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Now click the Run button on the top ribbon. This will download the job to the camera. At 
this point the job is ready to run and can be tested. However, in order to run the job 
change demo this job needs to be loaded into Slot 1. Click back to the Edit view from the 
top ribbon bar.

Click the slot icon and select Slot 1 or New Slot if no slots are currently in use. 

Now the job and images will be saved to the flash memory of the camera.
12-6 AutoVISION and Visionscape Industrial Protocol User Manual



STEP 7 Setup

P
R

O
F

IN
E

T
 I/

O
 B

lo
b

 
C

o
u

n
t 

D
em

o

12
STEP 7 Setup
This section was created using Siemens STEP 7 software version 5.5 + 
SP2 and an ET200S PLC, catalog number 6ES7 151-8AB01-0AB0, CPU 
Version 3.2. It was tested with a 315-2 PN/DP PLC, catalog number 
6ES7-315-2EH13-0AB0, CPU Version 2.6.

First launch the SIMATIC Manager from the desktop.

Create a new project from the menu item File > New. Select the project 
location on disk then enter the name and click the OK button. In the 
example below, the name is Start. Once the project is first created, you 
will see the dialog. This dialog is the main entry point into the PLC 
program and hardware settings.
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The PC may have multiple network cards so it’s imperative to map the 
correct one to the SIMATIC software. From the menu, select Options > 
Set PG/PC Interface. This will open the Set PG/PC Interface dialog and 
list the available network cards. On the Access Path tab select the NIC 
card with (TCP/IP >) in the name.

In the SIMATIC Manager dialog, right-click and select Insert New Object. 
This is where you will select the base station. For example, when 
configuring an ET200-s, select SIMATIC 300 Station since it’s based on 
the 300 series CPU.
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After the station has been added, right-click and add Industrial Ethernet.

Expand the Start tree node on the left pane and click the station. On the 
right pane you will see a Hardware icon.
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Double-click the Hardware icon to launch the HW Config dialog.

Make sure the Catalog is selected in the ribbon bar on the top. This will 
add a tree view on the right pane with all the available hardware devices.

If the latest GSDML file hasn’t been imported, follow the next steps to 
import.

GSDML

• Install the GSD file from the menu item Options > Install GSD File.

• Click the Browse button to locate the GSDML file \di-
soric\Vscape\Firmware\gsd\CS50 Sensor.
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• The center pane will list the available GSDML files.

• Select the file and click the Install button.

• When finished, close the dialog.

• The camera should now be present in the PROFINET I/O section 
under Additional Field Devices > General.
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Add the CPU from the catalog view by drag and drop or double-click. Make sure the 
catalog number and version matches the PLC exactly. The catalog number will be 
displayed on the bottom of the view.

Some CPUs are modules that will require a generic rack to be added prior. If your PLC 
requires a rack, you will be prompted to add the rack prior to being allowed to insert the 
CPU module.

After the CPU is added, a popup dialog will prompt the Properties relating to the IP 
information.
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Select Ethernet(1) on the bottom list box and enter the correct IP address of the CPU.

Once the CPU has been added, add any additional expansion modules, if installed. Click 
the CPU on the left pane and the bottom pane will list the available ports and slots.

Add the camera in the location (PROFINET I/O > Additional Field Devices > General > 
di-soric). The camera can be added by drag and drop to Ethernet(1): PROFINET-I/O 
System (100) or by selecting the Ethernet(1) line first and double-clicking the camera. 
Once the camera has been added the icon will appear on the configuration dialog.
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Once the camera has been added, double-click the icon to open the properties dialog. 
Under the device name, enter the existing name of the camera or a unique name.

If a unique name is used, the device has to be manually updated. View Updating camera 
name section.
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Click the camera icon and the data slot address mapping will be displayed below. Take 
note of the address values since they will be needed in the demo application. Since there 
is an infinite combination of modules and slot configurations, the addressing is unique to 
every setup.
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This demo uses the Boolean In and Float In for data. To the right under PROFINET I/O 
CS50 Sensor, click on Boolean In. This will highlight its appropriate slot. Drag and drop 
this to the highlighted slot. Repeat this for the Float In. The table should now appear as 
shown below.
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Once the hardware configuration has been completed, it’s time to compile and download. 
Click the compile and save icon on the ribbon. If there are any configuration conflicts, the 
application will prompt a warning at this point.

Once compiled, click the download icon on the ribbon to send the information to the PLC.

At this point close or minimize the HW Config dialog and re-visit the SIMATIC Manager 
dialog. The CPU should be added next to the Hardware icon and in the tree view in the left 
pane. Expand the CPU tree item and remaining child items below it.

Click the Blocks node to view the program objects.
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Updating Camera Name 

From the HW Config dialog open Edit Ethernet Node from the menu item PLC > 
Ethernet > Edit Ethernet Node. From the SIMATIC Manager dialog open Edit Ethernet 
Node from the menu item PLC > Edit Ethernet Node.

Click the Browse button to open the node selection dialog.

Select the camera and click the OK button.

Edit the Device Name, if necessary, to match the name entered previously in the CS50 
Sensor properties dialog, and click the Assign Name button.
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Importing Example Program
From the SIMATIC Manager, open the example program from the menu File > Open. 
Click the Browse button to locate the (BlobDemo) program. The BlobDemo is located in 
\di-soric\Vscape\Tutorials and Samples\CS50 Sensor\PROFINET Demo\ 
Step7_Demos\Circle_LocatorDemo\S7Circle_LocatorDemo\Circle_LocatorDemo.s7p.

Split both example and current projects in the dialog as shown.

Select the objects minus the System data object and copy with a right-click and Copy or 
CTRL + C. Paste into the current project with a right-click > paste or CTRL + V. When 
prompted that OB1 already exists, click the Yes button to overwrite it. Now the example 
program is imported to the current project.
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Select the Blocks icon on the left pane. Then click the download button on the top ribbon. 
This will download the new copied functions and system data to the PLC. Now it’s time to 
update the new addressing from the hardware installation prior. Double-click the OB1 
block to open the LAD/STL/FBD editor. OB1 is the main routine of the PLC program.
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Scroll down to Network 1. This is where the data is mapped from the camera to the local 
data structure. FC1 is a function that pushes the input data from the camera to the 
program structure. Click the numbers to match the address on the hardware as shown. 
Click the following buttons on the popup dialogs:
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Note: This is the address mapping view of the CS50 Sensor module which is derived from 
the hardware config view. 

The addresses on the right must be copied to Network 1 to match. Ex: HW config shows 
Status as address 0..1. Copy 0 into Network 1, STATUS value.

Repeat the same steps for Network 6 to update the output data mapping. Keep in mind 
that all input addresses are under the (I address) column and the output addresses are 
under the (Q address) column. Save to the PC and download to the PLC.

Do a master reset and set the PLC to RUN mode. Make sure all LEDs indicate good.
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Running the Demo

In the SIMATIC Manager dialog, double-click the VAT_1 icon. This will open the variable 
table dialog for the data type demo. Maximize the internal dialog to increase the viewing area.

To establish a live connection to the PLC, click the Monitor Variable button on the ribbon. 
This will update data from the PLC to the dialog. The top title bar will go blue and the 
bottom status will show run with a green progress bar.
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The following operations can be tried here:

Change Jobs + Get Current Job Slot

Be sure to follow instructions in the CS50 Software Setup section to store a job in a slot in 
the camera memory. To properly execute this test, load another job into slot 2 of the 
camera. For example, the Circle_LocatorDemo job. CS50 Software must be closed to run 
this Demo.

Using the VAT_1 elements ChangeJob and New_JobSlot. Click the Modify value 
column next to New_JobSlot, type 2, and type Enter. Click on the Modify Value column to 
the right of ChangeJob and enter TRUE. Click the icon indicated at the top.

The current job will be changed to the job in slot 2. To verify this, clear all changes made 
to the Modify value column, and click Modify value to the right of Get_CurrentJobSlot. 
Enter TRUE, and click on the indicated icon again.

You will see the current job listed to the right of Current_JobSlot. You may repeat this 
procedure changing the slot back to 1 and verify the current job slot is now 1.
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Trigger an Inspection and Reset Counters

Be sure the current job selected is slot 1. Clear any changes made to the Modify value 
column. If you want to watch the inspection, be sure CS50 Software is running, and 
connected to the device. Be sure the job is running. If you choose not to run CS50 
Software, you may look at the LEDs on the device to confirm your triggers. Change the 
value to the right of Trigger to TRUE, and click the indicated icon. 

You will see various changes as shown above. The pass and fail bools will indicate 
whether the inspection has passed or failed. Also, the appropriate counters will have 
incremented. Each click of the icon will cause an inspection which will bounce from one 
image to the next. One will pass and the next will fail. 
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Reset Counters

To reset the counters, clear all settings in the Modify value column, change the one next to 
ResetCounters to TRUE, and click the icon again. You will see all the counters in blue 
reset to 0.

If you clear this again and set the Trigger to TRUE, and click the lightning bolt button again, you 
will notice that the counts start at 1 on both the PLC counters and CS50 Software counters. 

Reset Error

If at any time there is an error indicated by a TRUE in any of the values below, you can 
clear the error by entering a TRUE to the right of ResetError and clicking the icon. Reset 
it to FALSE and click the button again. Any errors in the values below should be cleared.
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